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RPGA® Sanctioned Play

Most likely you ordered this adventure as part of an RPGA event from the RPGA website, or you received it from your senior gamemaster. To play this adventure as part of the Living Greyhawk campaign—a worldwide, ongoing D&D® campaign set in the Greyhawk setting—you must sanction it as part of an RPGA event. This event could be as elaborate as a big convention, or as simple as a group of friends meeting at the DM’s house. 


To sanction an RPGA event, you must be at least a Herald-Level™ gamemaster. The person who sanctions the event is called the senior gamemaster, and is in charge of making sure the event is sanctioned before play, runs smoothly on the date sanctioned, and then reported back to the RPGA in a timely manner. The person who runs the game is called the session Dungeon Master (or usually just DM). Sometimes (and almost all the time in the cases of home events) the senior gamemaster is also the session DM. You don’t have to be a Herald-Level GM to run this adventure if you are not the senior GM. 


By sanctioning and reporting this adventure you accomplish a couple of things. First, it is an official game, and you can use the AR to advance your Living Greyhawk character. Second, players and DMs gain rewards for sanctioned RPGA play if they are members of the Dungeons & Dragons Rewards program. Playing this adventure is worth two (2) points. 


This adventure retires from RPGA-sanctioned play on December 31, 2008. 


To learn more about the Living Greyhawk character creation and development, RPGA event sanctioning, and Dungeons & Dragons Rewards, visit the RPGA website at www.rpga.com. 

Players Read No Farther

If you are planning on playing this adventure, stop reading now. The rest of the information in this adventure is for the DM only. If you read farther than this section, you’ll know too much about its challenges, which kills the fun. Also, if you’re playing this adventure as part of an RPGA-sanctioned event, reading beyond this point makes you ineligible to do so. 

Preparing for Play

To get the most out of this adventure, you need copies of the following D&D rule books: Player’s Handbook, Dungeon Master’s Guide, and the Monster Manual. 

Throughout this adventure, text in bold italics provides player information for you to paraphrase or read aloud when appropriate. Information on nonplayer characters (NPCs) and monsters appear in abbreviated form in the adventure text. Refer to Appendix 1 for full information on NPCs and monsters. For your convenience, Appendix 1 is split by APL


Along with this adventure, you’ll find a RPGA session tracking sheet. If you’re playing this adventure as part of an RPGA-sanctioned event, complete and turn in this sheet to your senior GM directly after play. You’ll also find a Living Greyhawk adventure record (AR). You need one copy of this for each participating player.
 Living Greyhawk Levels of Play

Because players bring their own characters to Living Greyhawk games, this adventure’s challenges are proportionate to the modified average character level of the PCs participating in the adventure. To determine this modified Average Party Level (APL) follow the steps below:

1. Determine the character level for each of the PCs participating in the adventure.

2. If PCs bring animals that have been trained for combat (most likely dogs trained for war), other than those brought by virtue of a class ability (such as animal companions, familiars paladin’s mounts), use the table below to determine the number of levels you add to the sum of step one. Animals with different CRs are determined separately using the chart below; then, take the highest CR animal (or animals), and add 2 (drop fractions). A single PC may only bring four or fewer animals of this type. 

	Mundane Animals Effect on APL
	# of Animals

	
	1
	2
	3
	4

	CR of Animal
	1/4 & 1/6
	0
	0
	0
	1

	
	1/3 & 1/2
	0
	0
	1
	1

	
	1
	1
	1
	2
	3

	
	2
	2
	3
	4
	5

	
	3
	3
	5
	6
	7

	
	4
	4
	6
	7
	8

	
	5
	5
	7
	8
	9

	
	6
	6
	8
	9
	10

	
	7
	7
	9
	10
	11


3. Sum the results of step 1 and 2, and divide by the number of characters playing in the adventure. Round to the nearest whole number.

4. If you are running a table of six PCs, add one to that average.
Throughout this adventure, APLs categorize the level of challenge the PCs face. APLs are given in even-numbered increments. If the APL of your group falls on an odd number, ask them before the adventure begins whether they would like to play a harder or easier adventure. Based on their choice, use either the higher or the lower adjacent APL.


APL also affects the amount of experience and gold a PC can gain at the end of the adventure. If a player character is three character levels or more either higher or lower than the APL at which this adventure is being played, that character receives only one-half of the experience points and gold for the adventure. This simulates the fact that either the PC was not challenged as much as normal or relied on help by higher-level characters to reach the objectives.


Furthermore, a PC who is four or more levels higher than the highest APL supported by the adventure may not play the adventure.


Living Greyhawk adventures are designed for APL 2 and higher. Four or five 1st-level characters may find the challenge of an APL 2 adventure difficult. Suggest the following to these groups to help increase their chances of success: 

1. Enlist a sixth player.

2. Advise characters to buy riding dogs to help protect them and fight for them.

Time Units and Upkeep

This is a standard number-round Core adventure, set in location. All characters pay x Time Units per round.


Adventurer’s Standard Upkeep costs 12 gp per time unit. Rich Upkeep costs 50 gp per time unit. Luxury Upkeep costs 100 gp per time unit. Characters that fail to pay at least Standard Upkeep will retain temporary ability damage until the next adventure, must buy new spell component pouches and healer’s kits, and may suffer other in-game penalties (or possibly gain in-game benefits) as may be detailed in this adventure.


A character that does not pay for at least Standard Upkeep may also avoid the above-described penalties by living off the wild. If the character possesses four or more ranks in the Survival skill and succeeds at a DC 20 Survival check, the character will heal temporary ability damage as if he or she paid for Standard Upkeep, may refill spell component pouches and healer’s kits, and may restock up to 20 arrows or bolts if the character has at least four ranks in Craft (bowmaking). The player is allowed to Take 10 on this roll.


More information about lifestyle and upkeep can be found in the Lifestyle and Upkeep section of Chapter 3 of the Living Greyhawk Campaign Sourcebook.

Adventure Background

This section details any history that is relevant to your adventure.
Adventure Summary

This section contains the judge’s introduction and background and summary of adventure flow (encounter 1, encounter 2, etc. Remove this paragraph.
Preparation for Play

This section summarizes any information that the judge should determine about the participating PCs prior to the adventure beginning. For example, this could include determining whether the PCs possess a particular Favor or item. It can also be used for pre-rolled skill checks if you do not wish to alert the players that something is happening (for example, having elf characters pre-roll Search checks if a secret door is located somewhere in the adventure). 

Include here all relevant AR items from previous adventures.

Also include here notes on any monsters, spells, feats, and so on that are affected by the official FAQ or erratas. 
New Rule Items
Core adventures often utilize new rules items –including new classes, prestige classes, races, feats, spells, and equipment (including magic items) – that do not appear in any of the three core D&D books (Player’s Handbook, Dungeon Master’s Guide, or Monster Manual). The full write-up of any featured feats, spells, or equipment appears in Appendix 2. Information on featured classes, prestige classes, and races appears in the relevant creature’s stat block. All the information required to run these characters is presented in this adventure. The DM should double-check that he fully understands any new rule items presented in this adventure before play begins.
Introduction

The adventure starts here. This section includes the introduction to get the player characters involved in the adventure. Remove this paragraph.
1: The Sample Encounter
Encounter 1 text goes here. Repeat this type of layout for each subsequent encounter. Each encounter is split up into subsections; below are the subsections, their descriptions, and the order in which they appear.

Text that should be read aloud should use the “Read Aloud Text” style. It provides a distinct format that will set it off from the other text in the adventure. Keep these sections as brief as possible. 
The path forks ahead. One path bends to the right, leading into a dense forest. Eerie noises emanate from those dark sylvan depths. The other path leads to the left into a group of craggy hills. A flock of vultures flies in lazy circles over those highlands. 
The section that follows the read-aloud text provides the DM with information on interesting features, NPCs, traps, and other specifics of the encounter that play off the read-aloud text. This information immediately follows the read-aloud text and is not set off in any special way. Simple encounters can get by with just a general description. However, a particularly complex encounter might require more structure.


For items that need statistics, use the following format:


Wooden Doors: 1 in. thick; hardness 5; hp 10; AC 5; Break DC 18.

Trap: This section describes in detail any traps (magic or mundane) that PCs might trigger in the encounter. Remember: dwarves can use their Search skill to locate difficult stonework traps just like rogues can, anyone can search for traps whose DC to find them is 20 or less, and anyone can take 20 on a search for traps. (See DMG 71-74 for example traps). Below is one such example: 


Poisoned Arrow Trap: CR 3; mechanical; touch trigger; manual reset; lock bypass (Open lock DC 30); Atk +12 ranged (1d8 plus poison, arrow); poison (Large monstrous scorpion venom, DC 14 Fortitude save resists, 1d4 Con/1d4 Con); Search DC 19; Disable Device DC 15.
Creatures: Describe any creature the PCs might encounter here. This section provides a physical description, mannerisms, general motivations, and background of the monster.


Include a creature’s abbreviated statistics. Monsters presented in the Monster Manual use the Monster Stat Block detailed below and include only the number of creatures appearing, the creatures’ hit points, and special equipment, as well as a Monster Manual page number for easy reference. Full statistics for creatures that cannot be found in the Monster Manual, such as creatures from new sources or advanced creatures, appear in Appendix 1.


An NPC’s hit points should equal the average of the potential variable total (what you can roll for) plus any modifiers due to feats, conditions, and the creature’s Constitution score. Round down any fractions. Remember that characters created using the elite array get maximum hit points from their first Hit Die.

Example: male human fighter 3; hp 30, Con 16. (10 + 5.5 + 5.5 + 9).
Use the following templates for the various types of stat blocks.


Abbreviated Stat Block: NPCs the PCs will not fight.


Mulroony: male gnome barbarian 12/rogue 6.


Abbreviated Stat Block with Skill Modifier: NPCs who may make a Skill check during the adventure, but who the NPCs are not expected to fight.


Teldarrin: male human sorcerer 14 (Sense Motive +5).


Monster Stat Block: Monsters that appear in the adventure as the standard Monster Manual variety monster.
APL 2 (EL 2)


Human Commoner Zombies (3): hp 10, 9, 8; Monster Manual 266.
APL 4 (EL 4)


Human Commoner Zombies (6): hp 10, 9, 9, 8, 8, 8; Monster Manual 266.
APL 6 (EL 6)


Troglodyte Zombies (6): hp 29, 28, 27, 27, 25, 24; Monster Manual 266.
Reference Stat Block: Advanced or class monsters or NPCs that the PCs may fight should not include the full stat block in the adventure text but, instead, a reference stat block should appear in the adventure text.
APL 2 (EL 2)


Gurlg the Thug: male human warrior 3; hp 24; Appendix 1. 
APL 4 (EL 4)


Gurlg the Thug: male human warrior 5; hp 40; Appendix 1.
APL 6 (EL 6)


Gurlg the Thug: male human warrior 7; hp 56; Appendix 1.
Full Stat Block: Advanced or classed monster or NPCs that the PCs may fight use this type of stat block. Full stat blocks are included in Appendix 1. The adventure text should only include the reference stat block shown above. 


The stat block below utilizes hidden text settings to keep track of the calculations required to ensure important parts of the character or NPC are correct. The editor uses this information to check the stat block’s calculations. An example of a stat block completed in the required format is included in Appendix 1.


To view hidden text click Tools > Options > View tab > Hidden Text. To hide hidden text follow the same procedure. 


After inserting hidden text check to make sure that the formatting of the stat block is still correct. Sometimes extra spaces creep in between normal and hidden text which moves commas and such. Bare this in mind when checking your formatting. 


To print hidden text click File > Print > Options > Hidden Text.
Tactics: Describe the opponent’s combat tactics here.


Treasure: This section lists any treasure that the PCs can find during the encounter.

Use the following format to list the treasure found in the encounter. 
Treasure: The PCs can gain the following treasure here:


APL A: Loot XX gp; Coin XX gp; Magic XX gp item name (XX gp each [if more than one]); Total XX gp.


Loot: The value per character of all mundane equipment found such as nonmagical weapons and armor. Calculate this figure by dividing the full market price of all found items by 12.


Coin: The per character value of all coins, gems, jewelry, works of art and so on. These items are sold at full market price. Calculate how much each character receives by dividing the full market price of all these items by 6.


Magic: List all magical and nonstandard items which the PCs find or gain access to. Follow each item by a gp value in parenthesis. Calculate this figure by dividing the full market price of the item by 12.


Total: Total value per character of all treasure.


Example:

APL 2: Loot 12 gp; Magic 13 gp; scroll of protection from arrows (13 gp); Total 25 gp.

APL 4: Loot 25 gp; Magic 180 gp; scroll of protection from arrows (13 gp), ring of protection +1 (167 gp); Total 205 gp.

APL 6: Loot 16 gp; Magic 214 gp; 2 potions of cure light wounds (8 gp each), scroll of haste (31 gp), ring of protection +1 (167 gp); Total 230 gp.

Development: Sometimes the PCs’ actions have unusual ramifications or affect later encounters. Describe these changes and developments here.

Conclusion

This section contains the wrap-up of the adventure. Include any rewards given to the characters, final explanations, and other conditions that the game master might need. Remove this paragraph.

Campaign Consequences
Experience Point Summary

To award experience for this adventure, add up the values for the objectives accomplished. Then assign the experience award. Award the total value (objectives plus roleplaying) to each character.

Generally, to award XP for a combat encounter the judge should award 30 XP per EL defeated in the encounter. So at APL 2 the party defeats a monster at EL 4 and gets 120 XP, while at APL 4 the monster is EL 6 awarding the party 180 XP. The XP that can be awarded in an adventure is subject to certain maximum amounts. Authors should refer to the Living Greyhawk Writer’s Guidelines for the most recent version of these rules including separate rules regarding the maximum amount of XP available for story awards and for discretionary roleplaying.
1: Encounter Name
Experience objective

APL 2 
AA XP

APL 4 
AA XP

APL 6 
AA XP

APL 8 
AA XP

2: Encounter Name
Experience objective

APL 2 
AA XP

APL 4 
AA XP

APL 6 
AA XP

APL 8 
AA XP

Story Award

Objective(s) met:

APL 2 
AA XP

APL 4 
AA XP

APL 6 
AA XP

APL 8 
AA XP

Discretionary roleplaying award

APL 2 
AA XP

APL 4 
AA XP

APL 6 
AA XP

APL 8 
AA XP

Note to authors: the roleplaying award and story awards must be 20% or less of the total award for the adventure and may only be awarded when less than the maximum number of ELs for the APL is used. 
Total Possible Experience
APL 2 
AA XP

APL 4 
AA XP

APL 6 
AA XP

APL 8 
AA XP

Sum of all experience awards above.
Treasure Summary

During an adventure, characters encounter treasure, usually finding it in the possession of their foes. Every encounter that features treasure has a “treasure” section within the encounter description, giving information about the loot, coins, and magic items that make up the encounter’s treasure.


The loot total is the number of gold pieces each character gains if the foes are plundered of all their earthly possessions. Looting the bodies takes at least 10 minutes per every 5 enemies, and if the characters cannot take the time to loot the bodies, they do not gain this gold. If you feel it is reasonable that characters can go back to loot the bodies, and those bodies are there (i.e., not carted off by dungeon scavengers, removed from the scene by the local watch, and so on), characters may return to retrieve loot. If the characters do not loot the body, the gold piece value for the loot is subtracted from the encounter totals given below.


The coin total is the number of gold pieces each character gains if they take the coin available. A normal adventuring party can usually gather this wealth in a round or so. If for some reason, they pass up this treasure, the coin total is subtracted from the encounter totals given below.


Next, the magic items are listed. Magic item treasure is the hardest to adjudicate, because they are varied and because characters may want to use them during the adventure. Many times characters must cast identify, analyze dweomer or similar spell to determine what the item does and how to activate it. Other times they may attempt to use the item blindly. If the magic item is consumable (a potion, scroll, magic bolts, etc.) and the item is used before the end of the adventure, its total is subtracted from the adventure totals below.


Once you have subtracted the value for unclaimed treasure from each encounter add it up and that is the number of gold pieces a characters total and coin value increase at the end of the adventure. Write the total in the GP Gained field of the adventure certificate. 

Loot = Looted gear from enemy; Coin = Coin, Gems, Jewelry, and other valuables; Magic = Magic Items. Do not list a category if the PCs find no treasure belonging to it. For example if the PCs find no coins or gems do not list “Coin” in the treasure summary. To calculate the amount of gold each PC gets from selling an item divide its full market price by 12.
1: Introduction

APL 2: Coin: 50 gp.

APL 4: Coin: 50 gp.

APL 6: Coin: 50 gp. 
2: Encounter Name
APL 2: Loot 12 gp; Magic 13 gp; scroll of protection from arrows (13 gp); Total 25 gp.

APL 4: Loot 25 gp; Magic 180 gp; scroll of protection from arrows (13 gp), ring of protection +1 (167 gp); Total 205 gp.

APL 6: Loot 16 gp; Magic 214 gp; 2 potions of cure light wounds (8 gp each), scroll of haste (31 gp), ring of protection +1 (167 gp); Total 230 gp.
Treasure Cap

APL 2:



APL 4:


APL 6:


APL 8:

Total Possible Treasure

APL 2:



APL 4:


APL 6:


APL 8:

Adventure Record Items
List all things to be included on the AR. You should not include any item to which the PCs have “core” access (listed in the Living Greyhawk Campaign Sourcebook). Because of space limitations, this section should have a maximum of 450 words. This equates to roughly 2,400 characters (including spaces). 
Favor of Gurd Firebeard: You have performed a valuable service for the Ironcart clan of dwarves in the Rakers Mountains and have earned the favor of their cleric, Gurd Firebeard. When you use this favor, Gurd Firebeard will upgrade one of your magical weapon with halfling bane special ability. You must still pay the full difference in market value for the upgrade. You may only use this favor once.
Item Access

APL 2:

· Wand of cure light wounds (Adventure; DMG)
APL 4 (all of APL 2 plus the following):

· Slippers of spider climbing (Adventure; DMG)
APL 6 (all of APLs 2-4 plus the following):

· +2 greatsword (Adventure; DMG)
· Goggles of day (Adventure; CL 3rd; Libris Mortis; 4,500 gp)
Only include CL and cost information for non-standard items. See the goggles of day entry, above, for how to lay out a nonstandard item. 


This section of the AR only has space for 20 lines of text detailing magic items; do not exceed this limit, as excess items will be removed.
Appendix 1: APL 2

This appendix is for listing the various monsters that are not straight out of the MM. Break the encounters down by APL and list the full stat block of all non-standard monsters. Sort the monsters by encounter.
1: Encounter Name




Monster Name
CR XX
Gender race class level
*list non core race or class source 
AL Size type (subtype)

Init +X; Senses Listen +X, Spot +X
Aura 

Languages Common 

AC XX, touch XX, flat-footed XX

(+/-X size, +/-X Dex, +X class, +X armor, +X shield, +X deflection, +X insight, +X natural)

Miss Chance 

hp XX (XX HD); regeneration/fast healing; DR 

Immune 
Resist ; SR XX
Fort +X (+X against poison), Ref +X, Will +X
Race F+#, R+#, W+#; Class F+#, R+#, W+#; Abilities Con +##, Dex +##, Wis +##; other bonuses

Weakness 
Speed xx ft. in armor type (xx squares), base movement xx ft., other movement mode XX ft.;

Melee weapon +X[+/-X size, +X BAB, +X Str, +X weapon, +X feat] (damage) or/and
Ranged weapon +X[+/-X size, +X BAB, +X Dex, +X weapon, +X feat] (damage)
Space X ft.; Reach X ft.

Base Atk +X; Grp +X [+x size, +x BAB, +x Str,+x feat]
Atk Options 

Special Actions 

Combat Gear 

Class Spells Prepared (CL Xth):


9th—


8th—


7th—


6th—


5th—


4th—


3rd—


2nd—


1st—


0—

D: Domain spell. Deity: XX. Domains: Name, Name 

OR

Class Spells Known (CL Xth):

9th (x/day)—


8th (x/day)—


7th (x/day)—


6th (x/day)—


5th (x/day)—


4th (x/day)—


3rd (x/day)—


2nd (x/day)—


1st (x/day)—


0 (x/day)—

(Already cast

Spell-Like Abilities (CL Xth):

At Will—

3/day—


2/day—

1/day—

(Already cast

Abilities Str XX[xx array, +/-x racial, +x HD boost, +x item], Dex XX[xx array, +/-x racial, +x HD boost, +x item], Con XX[xx array, +/-x racial, +x HD boost, +x item], Int XX[xx array, +/-x racial, +x HD boost, +x item], Wis XX[xx array, +/-x racial, +x HD boost, +x item], Cha XX[xx array, +/-x racial, +x HD boost, +x item]
SQ 
Feats Feat#, Feat#, Feat#, Feat#, Feat# 

Skills total ranks: class XX Skill +#[+x size, +x ranks, +x ability, +x synergy, +x speed, -X armor], Skill +#[+x size, +x ranks, +x ability, +x synergy, +x speed, -X armor], Skill +#[+x size, +x ranks, +x ability, +x synergy, +x speed, -X armor], Skill +#[+x size, +x ranks, +x ability, +x synergy, +x speed, -X armor],
Possessions combat gear plus 

Spellbook spells prepared plus 0—

Special Attack/Quality (XX) 

Special Attack/Quality (XX) 

Special Attack/Quality (XX) 

Skills 

APL 4
APL 6
APL 8
Appendix 2: New Rules Items
Feats

List alphabetically. Include source and page reference like so:

Scorpion’s Resolve 
Like the scorpion, you are not easily distracted.


Benefit: You gain a +4 bonus on saving throws against mind-affecting spells and abilities.


Source: Sandstorm 53
Magic Items

List alphabetically; see above.
Mundane Equipment

List alphabetically; see above.

Spells

List alphabetically; see above.

DM Maps

Insert DM maps. At the minimum, each combat encounter should have a map. If the adventure includes significant amounts of travel also include an area map.
Player Handout X
Player handouts go in this section. Use page breaks between each. If you don’t have any handouts, remove this section. 
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